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The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you 
have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 
You agree not to reproduce, other than for your own personal, noncommercial use, all or part of 
this document on any medium whatsoever without permission of Schneider Electric, given in 
writing. You also agree not to establish any hypertext links to this document or its content. 
Schneider Electric does not grant any right or license for the personal and noncommercial use of 
the document or its content, except for a non-exclusive license to consult it on an "as is" basis, at 
your own risk. All other rights are reserved.
All pertinent state, regional, and local safety regulations must be observed when installing and 
using this product. For reasons of safety and to help ensure compliance with documented system 
data, only the manufacturer should perform repairs to components.
When devices are used for applications with technical safety requirements, the relevant 
instructions must be followed. 
Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment damage.
Schneider Electric hereby informs the users of the Harmony XB5S product that they are 
responsible for the fulfillment, with the competent local authority regarding data privacy protection, 
of any formalities which could be required in relation with the use of a biometric product.
© 2019 Schneider Electric. All rights reserved.
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Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device 
before trying to install, operate, service, or maintain it. The following special messages may appear 
throughout this documentation or on the equipment to warn of potential hazards or to call attention 
to information that clarifies or simplifies a procedure.
EIO0000001538 04/2019 5



PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified 
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of 
the use of this material.
A qualified person is one who has skills and knowledge related to the construction and operation 
of electrical equipment and its installation, and has received safety training to recognize and avoid 
the hazards involved.
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About the Book
At a Glance

Document Scope
This document describes the functions of Harmony XB5SSoft that are used for the management 
of XB5S device databases.

Validity Note
This document is valid for Harmony XB5SSoft V2.
EIO0000001538 04/2019 7



8 EIO0000001538 04/2019



Harmony
Overview
EIO0000001538 04/2019
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Chapter 1
Overview of Harmony XB5SSoft

At a Glance
The Harmony XB5SSoft database management program allows you to program all the biometric 
switches in your XB5S park from one PC.

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
GDPR Introduction 10
Harmony XB5SSoft Introduction 11
Additional Software Information 15
EIO0000001538 04/2019 9



Overview
GDPR Introduction

Generalities
GDPR (General Data Protection Regulation) is a regulation in EU law on data protection and 
privacy for all European individuals. GDPR is dedicated for only EU area and it provides data 
protection and privacy for all European citizens in EU.
The general data protection regulation (2016/679) was replaced with “Data Protection Directive 
95/46/EC” in 2016. GDPR was come into operation at 25th of May 2018.
Schneider Electric upgraded their products with GDPR-related features to increase the strength of 
protection against attack when each individual biometric data is collected.
On the other hand, Schneider Electric provides some set of guides to their clients how to get a 
proper installation in their site. These sets of guides (Security insurance plan, getting started, 
Instruction Sheet) are visible in www.se.com website.
GDPR logo on the software:

When you connect to GDPR compliance product through software, GDPR logo appears in the 
column side. This provides you to be ensured that you connect the software with GDPR mode.

Fingerprint Record Feature 
The complete fingerprint is not recorded in the XB5S device and in the Harmony XB5SSoft. The 
fingerprint data cannot reproduce a fingerprint that can be used for identification.
10 EIO0000001538 04/2019
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Overview
Harmony XB5SSoft Introduction

Generalities
Harmony XB5SSoft can use two types of devices:
 XB5S device
 MorphoSmartTM Device:
You can use Harmony XB5SSoft to manage all your USB biometric switches from one PC by 
downloading (storing) a user database to each XB5S device in your park. You can also erase 
(reset) all information in an XB5S device.
Harmony XB5SSoft manages 2 databases:
 Administrators database:
 Configuration-administrator (see page 12)
 Users-administrator (see page 13)

 Users database:
 Users (see page 13)

XB5S device
The XB5S device which connects to the PC running Harmony XB5SSoft via a USB port is only a 
fingerprint reader.
XB5S device aims to be used to protect access to restricted area, or equipment by controlling 
fingerprint. When a finger is recognized, it activates its boolean output to enable the access. It can 
also be used as a fingerprint reader.
It needs an external 24 Vdc power supply.

MorphoSmartTM Device

The MorphoSmartTM device is a fingerprint reader only.
It connects to the PC running Harmony XB5SSoft via a USB port.
It does not contain any fingerprint data.

The MorphoSmartTM device does not need an external power supply; it is powered through the 
USB connection.
Thus, you can use it to record fingerprints in your office instead going to an XB5S device located 
away from your office. It can be used as well to authenticate an administrator.
EIO0000001538 04/2019 11



Overview
Configuration-Administrators
The configuration-administrator authorizes:
 Managing administrators (create, delete, and modify)
 Managing the configuration of the software (language, Automatic software-lock timeout, 

database paths)
 Dealing with GDPR-related features:
 Activate or not the GDPR-related features of the software
 Process GDPR-related functions such as user’s personal data export

NOTE: If there remains only one configuration-administrator enrolled, this configuration-
administrator cannot be deleted.
The administrator database contains, for each enrolled administrator, the following information:
 Administrator identifier (ID)

Each administrator identifier must be unique.
 1 or 2 fingerprints (Finger 1, Finger 2)
 Date of enrollment (Date of record)
 ID of the configuration-administrator who enrolled this administrator (Recorded by)

GDPR RECOMMENDATION

RISK IF THERE IS ONLY ONE CONFIGURATION-ADMINISTRATOR
It is strongly recommended to record more than one configuration-administrator.
Should the single configuration-administrator become no longer available, it will be impossible to export user 
personal data.
Failure to follow these instructions can make it more difficult to comply with GDPR requirements.

GLOBAL RECOMMENDATION
RISK IF THERE IS ONLY ONE CONFIGURATION-ADMINISTRATOR
It is strongly recommended to record more than one configuration-administrator.
If you do not take this precaution, some important action will be impossible to execute in case of the 
configuration-administrator is no longer available, such as:
 Recording a new configuration-administrator
 Managing users-administrators (create, delete, modify, …)
 Modifying the software configuration
12 EIO0000001538 04/2019



Overview
Users-Administrators
The users-administrators authorize:
 Managing users (create, delete, and assignment)
 Storing of a user database in an XB5S device
 Resetting an XB5S device by storing an empty database in it
 Detaching an XB5S device from a user database (if, for example, it is to be replaced by another 

XB5S device)
 Deleting an XB5S device from a user database
The administrator database contains, for each enrolled administrator, the following information:
 Administrator identifier (ID)

Each administrator identifier must be unique.
 1 or 2 fingerprints (Finger 1, Finger 2)
 Date of enrollment (Date of record)
 ID of the configuration-administrator who enrolled this administrator (Recorded by)

Users
The users are authorized to operate equipment or access to a restricted area controlled by an 
XB5S device using their fingerprints.
The user database contains, for each enrolled user, the following information:
 User identifier (ID)

Each user identifier must be unique.
 Comments, for user-specific information, such as:
 The team the user belongs to
 The type of license or authorization the user is entitled to
 Any type of information that can help classify user authorizations for each XB5S device

 1 or 2 fingerprints (Finger 1, Finger 2)
 Date of enrollment (Date of record)
The user database is a matrix based on the relationship between the users and an XB5S device.
EIO0000001538 04/2019 13



Overview
Here is an example of a user matrix:

Users list XB5S Device Allocations list

ID(1) Finger 1 Finger 2 Date of 
Record

Comments Main 
Gate

Office 
Door

Forklift Station 1 Station 2

User 1 Right Middle 
Finger

2019-03-01 x x x x

User 2 Right index 2019-03-01 x x x
User 3 Right index 2019-03-01 x x
User 10 Right Thumb Right index 2019-01-02 x
User 11 Right Thumb Right index 2019-01-02 x
1 For GDPR recommendation, user's name must not be used.

GDPR RECOMMENDATION

RISK IF IDENTIFIER IS TOO EXPLICIT
The identifier of an administrator or a user must not be explicit.
It is strongly recommended to use pseudonym or codification for identifier.
Failure to follow these instructions can make it more difficult to comply with GDPR requirements.
14 EIO0000001538 04/2019



Overview
Additional Software Information

Prerequisites
The following operating systems are supported by Harmony XB5SSoft
 Microsoft Windows 7 32 bits
 Microsoft Windows 7 64 bits
 Microsoft Windows 10 32 bits
 Microsoft Windows 10 64 bits
Updates of Harmony XB5SSoft are automatically signaled as notifications by the “Schneider 
Electric Software Update” embedded tool. It provides the capability to download and install directly 
the notified update.
It is also possible to find the latest version of Harmony XB5SSoft by going to www.se.com. Then 
search on “XB5S”.
Be sure to save Harmony XB5SSoft so that you do not lose updated databases in case of a 
problem with your PC.

Vijeo Designer
Vijeo Designer is no more supported by Harmony XB5SSoft starting from version software V2.0 
and higher.
Vijeo Designer is only supported by Harmony XB5SSoft version software V1.1.

Conventions
The following typographic conventions are used in this operation guide.

Menus
The tasks explained in this document use the icons and the right-click contextual menus to access 
functions. However, all these functions are also available in the menus.

Format Represents
Bold For user input, enter words or phrases shown in bold as they appear. Menu names and 

options, commands and toolbar names, and dialog box names and options are also 
shown in bold type.

UPPER CASE Keyboard names, combinations, and sequences are shown in all uppercase letters. 
For example, the keyboard shortcut for creating a new application is CTRL+N. To 
perform this shortcut, press and hold the CTRL key and then press the N key.

File → Open The arrow indicates a menu selection. In this instance, go to the File menu to select the 
Open command.
EIO0000001538 04/2019 15



Overview
Online/Offline
In the procedures of this document, Online/Offline information is indicated when:
 Offline:

These are manipulations that can be done when no XB5S device or MorphoSmart device is 
connected to the PC.

 Online:
These are manipulations that require an XB5S device or MorphoSmart device to be connected 
to the PC.
16 EIO0000001538 04/2019
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Chapter 2
Configuration

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Configuration at First Launch 18
Harmony XB5SSoft Configuration 28
EIO0000001538 04/2019 17



Configuration
Configuration at First Launch

First Launch
The first time you launch Harmony XB5SSoft, the Initial setup procedure starts.

The Initial setup procedure is composed by 6 steps:
 STEP A - Declare first configuration-administrator (see page 19)
 STEP B - GDPR setup guidance (see page 20)
 STEP C - Configuration settings (see page 21)
 STEP D - Register first configuration-administrator fingerprints (see page 22)
 STEP E - Add users-administrator (see page 25)
 STEP F - Register additional configuration-administrator (strongly recommended) 

(see page 27)
The Initial setup procedure is designed as a step-by-step wizard. At each step, click Details to get 
relevant information.
At each step, you can either:
 Click Start step to run the highlighted step
 Click Previous Step to go back to the previous step
 Click Close to close Initial setup procedure window & Harmony XB5SSoft
This wizard is displayed at Harmony XB5SSoft launch as long as all the mandatory steps be done.
Once the Initial setup procedure is finished (end of STEP E or STEPF), the End of Initial setup 
procedure (see page 27) dialog opens.
18 EIO0000001538 04/2019



Configuration
STEP A - Declare First Configuration-Administrator

Step Action
1 The Declare first configuration-administrator dialog opens.

Fulfill the fields:
 ID: Identifier of the first configuration-administrator
 Password
 confirm password

Type any Comments for the administrator to be added.
2 Select the Administrator’s profile.

It is possible to select both profiles.
The possibility to merge the profiles of configuration-administrator and users-administrator is 
provided to enhance ease-of-use (in the context of small organizations for instance).

3 Click OK.
Result: The dialog closes and the next step becomes highlighted in the Initial setup procedure 
window.
EIO0000001538 04/2019 19



Configuration
STEP B - GDPR Setup Guidance

GDPR RECOMMENDATION

RISK IF ADMINISTRATORS PROFILES ARE MERGED
It is strongly recommended to keep two separate profiles:
 Configuration-administrator
 Users-administrator

Failure to follow these instructions can make it more difficult to comply with GDPR requirements.

Step Action
1 The GDPR setup guidance dialog opens.

Select Yes if you are located in Europe.
Select Yes if you intend to export your installation in Europe.

NOTE: If you have selected at least one Yes, your installation is submitted to GDPR policy 
about personal data protection. The Activate GDPR-related features will be pre-selected.

2 Click OK.
Result: The dialog closes and the next step becomes highlighted in the Initial setup procedure 
window.
20 EIO0000001538 04/2019



Configuration
STEP C - Configuration Setup

NOTE: Any time after the first launch, these configuration parameters can be modified. For more 
details, refer to Harmony XB5SSoft Configuration (see page 28).

Step Action
1 The Configuration dialog opens.

Select/clear the Activate GDPR-related features check box.
2 Select the language.
3 Select the Automatic software-lock timeout: disabled or 1 minute…60 minutes.
4 Type the Database file path or click ... to select a new path.

For more details, refer to Harmony XB5SSoft File Paths (see page 28).
5 Type the Log path or click ... to select a new path.

For more details, refer to Harmony XB5SSoft File Paths (see page 28).
6 Click OK.

Result: The dialog closes and an information window appears indicating that the First 
configuration-administrator and the software configuration have been saved.

7 Click Close.
Result: The dialog closes and the next step becomes highlighted in the Initial setup procedure 
window.
EIO0000001538 04/2019 21



Configuration
STEP D - Register First Configuration-Administrator Fingerprints
To perform this step, you need to connect a device (XB5S device or MorphoSmart device) to a USB 
port of the PC.
Add a XB5S device to a Harmony XB5SSoft: 

Add a MorphoSmart device to a Harmony XB5SSoft:

Step Action
1 Plug a XB5S device to a USB port on your PC.

Result: The Connection of a new device dialog opens.
2 Click Use it as a Harmony XB5S device.
3 Click Next.

Result: The Attachment of the connected XB5S to the allocation database dialog opens with 
Add a column in the database and attach this XB5S to it enabled.

4 Click Next.
Result: The Add a column dialog opens.

5 In Designation, type a unique name for this XB5S device.
In Comments, type and any necessary Comments.

6 Click Next.
Result: The New XB5S created! dialog opens.

7 Click Finish.
Result: The New XB5S created! dialog closes.

Step Action
1 Plug the MorphoSmart device to a USB port on your PC.

Result: The Connection of a new device dialog opens.
2 Click Use it as a fingerprint reader only.
3 Click Next.

Result: The message Reader saved!.
4 Click Finish.
22 EIO0000001538 04/2019



Configuration
Use this procedure to register first configuration-administrator fingerprints:

Step Action
1 The Register first configuration-administrator fingerprints dialog opens.

Select the name of the finger to be recorded in the Select 1st finger list.
2 Click Record 1st finger.

Result: The Fingerprint record dialog opens.
You have 30 seconds to start recording. After 30 seconds finishes, click Record 1st finger 
again to start the timer again.
EIO0000001538 04/2019 23



Configuration
3 Place the finger correctly on the sensor of the XB5S device or MorphoSmart device:

Hold the finger on the sensor about 2 seconds (sensor blink + 1 s) before removing it from the 
sensor.
Result:
 If the finger is already in the database, a message opens: The fingerprint is already in the 

database. Either click Cancel or choose another finger and continue.
 Otherwise, 1st capture in the Fingerprint record dialog changes from In progress to Done.

4 Repeat step 3.
Result: 2nd capture in the Fingerprint record screen changes from In progress to Done.

5 Repeat Step 3.
Result: 3rd capture in the Fingerprint record screen changes from In progress to Done.

6 It is recommended to repeat steps 1 to 5 for Record 2nd finger.
7 Click OK.

Result: The dialog closes and the next step becomes highlighted in the Initial setup procedure 
window.

GLOBAL RECOMMENDATION
RISK IF THERE IS ONLY ONE FINGERPRINT RECORDED
It is strongly recommended to record fingerprints of two fingers, if possible one of each hand.
If you do not take this precaution, some important action will be impossible to execute by the user or the 
administrator in case where his recorded finger is injured so that its fingerprint cannot be recognized.

Step Action
24 EIO0000001538 04/2019



Configuration
STEP E - Add Users-Administrator

Step Action
1 The Add administrator dialog opens.

Fulfill the fields:
 ID: Identifier of the users-administrator
 Password
 confirm password

Type any Comments for the administrator to be added.
EIO0000001538 04/2019 25



Configuration
2 Select the Administrator’s profile.
It is possible to select both profiles.
The possibility to merge the profiles of configuration-administrator and users-administrator is 
provided to enhance ease-of-use (in the context of small organizations for instance).

3 Record 1 or 2 fingerprints (see page 41) for the new users-administrator.
Click OK.
Result: The Add users-administrator dialog closes.
Result: The dialog closes and the next step becomes highlighted in the Initial setup procedure 
window.

GDPR RECOMMENDATION

RISK IF ADMINISTRATORS PROFILES ARE MERGED
It is strongly recommended to keep two separate profiles:
 Configuration-administrator
 Users-administrator

Failure to follow these instructions can make it more difficult to comply with GDPR requirements.

Step Action
26 EIO0000001538 04/2019



Configuration
STEP F - Register Additional Configuration-Administrator (Strongly Recommended)

End of Initial Setup Procedure
Once the Initial setup procedure is finished (end of STEP E or STEP F), a dialog opens. 
This dialog informs you that:
 The Initial setup procedure is completed.
 The Software is now ready to be used.
 To manage users and XB5S devices, a users-administrator will have to log in the next time the 

software will be launched.
Click Close.
Result: The End of initial setup procedure closes and the Harmony XB5SSoft main screen is 
displayed, with an empty user database.

Step Action
1 Repeat the STEP E (see page 25) procedure to add a second configuration-administrator.

NOTE: The ID must be new and the fingerprints must be new too.

Type the ID and any Comments for the administrator to be added.
2 Result: The Initial setup procedure closes and the End of initial setup procedure is displayed.

GDPR RECOMMENDATION

RISK IF THERE IS ONLY ONE CONFIGURATION-ADMINISTRATOR
It is strongly recommended to record more than one configuration-administrator.
Should the single configuration-administrator become no longer available, it will be impossible to export user 
personal data.
Failure to follow these instructions can make it more difficult to comply with GDPR requirements.

GLOBAL RECOMMENDATION
RISK IF THERE IS ONLY ONE CONFIGURATION-ADMINISTRATOR
It is strongly recommended to record more than one configuration-administrator.
If you do not take this precaution, some important action will be impossible to execute in case of the 
configuration-administrator is no longer available, such as:
 Recording a new configuration-administrator
 Managing users-administrators (create, delete, modify, …)
 Modifying the software configuration
EIO0000001538 04/2019 27



Configuration
Harmony XB5SSoft Configuration

Configuration
Any time after the first launch, the Harmony XB5SSoft configuration parameters can be modified 
by a configuration-administrator.

Harmony XB5SSoft File Paths
 Database file path:

By default, the administrator database and the user database are saved in 
C:/ProgramData/Schneider Electric/HarmonyXB5SSoft/Database. They are recorded in two 
files adminDatabase.xml and userDatabase.xml. These files are encrypted to avoid malevolent 
use and to help protecting personal data.

 Log file path:
By default, the log files (used to record the actions & events of Harmony XB5SSoft) are in 
C:/ProgramData/Schneider Electric/HarmonyXB5SSoft/Log. These files are signed to help 
signaling in case of attempt from unauthorized modification of their content.

NOTE: You can locate your databases in a shared area (a server) accessible by several PCs 
through a network. In this case, contact your network administrator to prevent multiple opening of 
the databases. Only one software user can access to the database at a time.
NOTE: The network administrator must also give to Harmony XB5SSoft users Windows read and 
write authorizations for the usersDatabase.xml and adminDatabase.xml files.

Step Action Online/Offline
1 Log to the Harmony XB5SSoft as a configuration-administrator. Offline
2 Plug an already attached or connect a new device (see page 32) (XB5S device 

or MorphoSmart device).
Online

3 Select in the menu command Tools → Configuration.
Result: The Administrator authentication dialog opens.

Online

4 Apply one of your enrolled fingers on the sensor of the XB5S device or the 
MorphoSmart device for 2 s.
The Configuration dialog opens.

Online

5 Select/clear the Activate GDPR-related features check box. Online
6 Select the language. Online
7 Select the Automatic software lock timeout: disabled or 1 minute…60 minutes. Online
8 Type the Database file path or click ... to select a new path.

For more details, refer to Harmony XB5SSoft File paths (see page 28).
Online

9 Type the Log path or click ... to select a new path.
For more details, refer to Harmony XB5SSoft File paths (see page 28).

Online

10 Click OK.
Result: The dialog closes and the software configuration is saved.

Online
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Configuration
Old Harmony XB5SSoft Database Version
At Harmony XB5SSoft Initial setup procedure first launch, if an old version of the database is 
detected by the software, a dialog opens asking you: An old version of the database has been 
detected do you want to load it. Click OK to load it.
EIO0000001538 04/2019 29
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Chapter 3
Connecting and Detaching Devices

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Connecting Devices 32
Detaching Devices 34
EIO0000001538 04/2019 31



Connecting and Detaching Devices
Connecting Devices

Connecting an XB5S Device
The procedure describes how to connect a XB5S device to a Harmony XB5SSoft database. The 
XB5S device is then usable exclusively with this database.
To unlink it, you can either detach (see page 34), reset (see page 58), or delete (see page 52) it 
from Harmony XB5SSoft.
To add an XB5S device to a Harmony XB5SSoft:

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as a users-administrator or as a configuration-
administrator.

Online

2 Plug the XB5S device to a USB port on your PC.
Result: The Connection of a new device dialog opens.

Online

3 Click Use it as a Harmony XB5S device. Online
4 Click Next.

Result: The Attachment of the connected XB5S to the allocation database dialog 
opens.

Online

5  If you click Add a column in the database and attach this XB5S to it:
Click Next and go to step 6.

 If you click Attach this XB5S to a column of the database:
Click Next and go to step 9.

Online

6 The Add a column dialog opens.
In Designation, type a unique name for this XB5S device and any necessary 
Comments.

Online

7 Click Next.
Result: The New XB5S created! dialog opens.

Online

8 Click Finish.
Result: There is now an empty column in Allocations for the connected XB5S device. 
The procedure is finished here for adding a new column.

Online

9 If you previously selected Attachment of the connected XB5S to the allocation 
database in Step 5, a dialog opens.
Choose a column in the dropdown list.

Online

10 Click Finish.
Result: The XB5S attached! dialog opens.
Click OK.

Online
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Connecting and Detaching Devices
Adding MorphoSmart Device
Use this procedure to add a MorphoSmart device to a Harmony XB5SSoft:

A MorphoSmart device:
 cannot be used to store or reset an XB5S device
 allows new user fingerprint recording
 allows administrators authentications

Device Information
For details about a connected XB5S device, use the menu command XB5S Device → About XB5S.
For details about a configured MorphoSmart device, use the menu command Tools → Reader 
devices.

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as a users-administrator or as a configuration-
administrator.

Online

2 Plug the MorphoSmart device to a USB port on your PC.
Result: The Connection of a new device dialog opens.

Online

3 Click Use it as a fingerprint reader only. Online
4 Click Next.

Result: The Reader saved! dialog opens.
Online

5 Click Finish. Online
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Detaching Devices

Detach XB5S Device for Replacement
An attached XB5S device is identified as being uniquely linked to a database. It cannot be 
programmed by another database.
Use this procedure to detach an XB5S device from its linked database so that it can be attached 
to another database:

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as a users-administrator. Online
2 Connect the XB5S device to be detached to a USB port on your PC.

Result: The statusbar of the Harmony XB5SSoft indicates that a XB5S is connected 
and the description of the attached column of the database.

Online

3 Right-click the Allocations column attached to the XB5S device. Online
4 Select Detach XB5S from column.

Result: The Administrator authentication dialog opens.
Online

5 Apply the current administrator finger to the XB5S device sensor for 2 s.
Result: The Detach XB5S from column dialog opens.

Online

6 Click OK.
Results:
 This XB5S device is reset (see page 58) and detached (see page 34) from the 

database.
 The message Device successfully detached! appears.

NOTE: The user allocations remain in the associated column. This allows attaching 
a new XB5S device to the column with the same configuration of allocations. For 
example, replacement of an XB5S device by another one.

Online

7 Click OK.
Result: The Connection of a new device dialog opens.

NOTE: This dialog opens because the connected XB5S device is no longer 
recognized by the database. It is now considered as a new connected device.

Online

8 Click Cancel. Online
9 Unconnect the XB5S device from its USB port. Online
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Delete MorphoSmart Device
Use the procedure to delete a MorphoSmart device from a Harmony XB5SSoft:

Device Information
For details about a connected XB5S device, use the menu command XB5S Device → About XB5S.
For details about a configured MorphoSmart device, use the menu command Tools → Reader 
devices.

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as a users-administrator. Offline
2 In the menu, select Tools → Reader Devices

Result: The Reader devices dialog opens.
Offline

3 Click the reader to be removed. Offline
4 Click Delete selected devices. Offline
5 Click OK.

Result: The Reader devices deleted! dialog opens.
Offline

6 Click OK.
Result: If the MorphoSmart device is connected, the Connection of a new device 
dialog opens.

Offline

7 Click Cancel, otherwise, click Close. Offline
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Chapter 4
Managing Administrators

Managing Administrators

Overview
Before using Harmony XB5SSoft, there has to be at least:
 One configuration-administrator (see page 12)
 One users-administrator (see page 13)
Only an enrolled configuration-administrator can manage administrators.

Administrator Enrollment
Use this procedure to add an administrator to the administrator database:

Step Action Online/Offline
1 Log to the Harmony XB5SSoft as a configuration-administrator. Offline
2 Do one of the following actions:

1. Click Key icon:

2. In the menu, select Tools → Manage Administrators
Result: The Administrator authentication dialog opens.

Online

3 Apply one of your enrolled fingers on the sensor of the XB5S device or the 
MorphoSmart device.
Hold the finger on the sensor about 2 seconds (sensor blink + 1 s) before removing it 
from the sensor.
Result: The Manage Administrators dialog opens.

Online

4 Click Add.
Result: The Administrator authentication dialog opens.

Online

5 Apply one of your enrolled fingers on the sensor of the XB5S device or the 
MorphoSmart device.
Hold the finger on the sensor about 2 seconds (sensor blink + 1 s) before removing it 
from the sensor.
Result: The Add Administrator dialog opens.

NOTE: You are now in the Online mode.

Online
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Managing Administrators
There are additional buttons on the Manage Administrators dialog:

6 Fulfill the fields:
 ID: Identifier of administrator
 Password
 confirm password

Type any Comments for the administrator to be added.

Online

7 Select the Administrator’s profile:
 Configuration-administrator
 Users-administrator
 Or both

The possibility to merge the profiles of configuration-administrator and users-
administrator is provided to enhance ease-of-use (in the context of small 
organizations for instance).

Online

8 Record 1 or 2 fingerprints (see page 41) for the new administrator. Online
9 Click OK.

Result: The administrator is added to the Manage Administrators list.
Online

GDPR RECOMMENDATION

RISK IF ADMINISTRATORS PROFILES ARE MERGED
It is strongly recommended to keep two separate profiles:
 Configuration-administrator
 Users-administrator

Failure to follow these instructions can make it more difficult to comply with GDPR requirements.

Step Action Online/Offline

Button Used to ... Online/
Offline

Delete Remove the selected administrator from the list.

NOTE: If there is only one configuration-administrator, it cannot be removed from the 
list.

Online

Modify Update the comments of the selected administrator. Online
Sort Sort the administrator list by the ID, Date of record, Recorded by, or Comments column. Online
Change 
password

Change the passwords of other administrators. Online

Close Close the Manage Administrators dialog. Online
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Change Your Password
Use this procedure to change your password:

Change the Passwords of Other Administrators
If an administrator lost its password, a configuration-administrator can allow him to enter a new 
password.
Use this procedure to change any password:

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft. Online
2 Select in the menu command Tools → Change Password.

Result: The Administrator authentication dialog opens.
Online

3 Apply one of your enrolled fingers on the sensor of the XB5S device or the MorphoSmart 
device for 2 s.
Result: The Change password opens.

Online

4 Fulfill the fields:
 Current password
 New Password
 Confirm new password

Online

5 Click Accept.
Result: the procedure changes the password of your current logged-in profile (user-
administrator or configuration-administrators).

Online

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as a configuration-administrator. Offline
2 Do one of the following actions:

1. Click Key icon:

2. In the menu, select Tools → Manage Administrators
Result: The Administrator authentication dialog opens.

Online

3 Apply one of your enrolled fingers on the sensor of the XB5S device or the MorphoSmart 
device for 2 s.
Result: The Manage Administrators dialog opens.

Online

4 Select the administrator who needs to change its password. Online
5 Click Modify.

Result: The Administrator authentication dialog opens.
Online
EIO0000001538 04/2019 39



Managing administrators
5 Apply one of your enrolled fingers on the sensor of the XB5S device or the MorphoSmart 
device for 2 s.
Result: The Modify Administrators dialog opens.

Online

6 The administrator who needs to change its password must fulfill the fields:
 password
 confirm password

Online

7 Click OK.
Result: The Administrator authentication dialog opens.

Online

8 The administrator that has changes its password must apply one of its enrolled fingers on 
the sensor of the XB5S device or the MorphoSmart device for 2 s.
Result: the procedure changes the password of the administrator (user-administrator or 
configuration-administrators).

Online

Step Action Online/
Offline?
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Chapter 5
Recording Fingerprints

Recording Fingerprints

Overview
To operate equipment controlled by an XB5S device, a user must have 1 or 2 fingerprints recorded 
in the XB5S device. By recording fingerprints for a user only 1 time in the Harmony XB5SSoft 
Users database, you can add the user to as many XB5S device as you want. The user does not 
need to manually record a fingerprint at each XB5S device.
NOTE: One configuration-administrator must have fingerprints recorded before enrolling new 
administrators.
All administrators can be added only by a configuration-administrator. 
Each recorded administrator has to record its own fingerprints. For this, he needs the authenti-
cation of current logged-in configuration-administrator.

Recording Fingerprints Procedure
Use this procedure to record a fingerprint:

Step Action Online/
Offline?

1 Access to one of the following dialogs:
 Add Administrators: Refer to Managing Administrators (see page 37).
 Add User: Refer to Managing Users (see page 44).
 Modify User: Double-click a User.

Online

2 Enter the requested information above Select 1st finger. Online
3 Select the name of the finger to be recorded in the Select 1st finger list. Online
4 Click Record 1st finger.

Result: The Fingerprint record dialog opens.
You have 30 seconds to start recording. After 30 seconds finishes, click Record 1st finger 
again to start the timer again.

Online
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5 Place the selected finger correctly on the sensor of the XB5S device or MorphoSmart 
device:

Hold the finger on the sensor about 2 seconds (sensor blink + 1 s) before removing it from 
the sensor.
Result: 1st capture in the Fingerprint record screen changes from In progress to Done.

Online

6 Repeat step 5.
Result: 2nd capture in the Fingerprint record screen changes from In progress to Done.

Online

7 Repeat Step 5.
Result:
 If the finger is already in the database, a message opens: The fingerprint is already in 

the database. Click Close. Go to step 4 and choose another finger.
 Otherwise, 3rd capture in the Fingerprint record dialog changes from In progress to 

Done.
You returned to either:
1. Add Administrator dialog
2. Add User dialog

Online

8 It is recommended to record a second fingerprint:
 Select the name of the finger to be recorded in the Select 2nd finger list.
 Repeat steps 3 to 7.

Online

9 Click OK to finish recording.
The new administrator or user is now recorded in Harmony XB5SSoft database.
You returned to either:
1. Add Administrator dialog: new administrator appears in the Manage Administrators list
2. Add User dialog: the new user appears in the Users list

Online

GLOBAL RECOMMENDATION
RISK IF THERE IS ONLY ONE FINGERPRINT RECORDED
It is strongly recommended to record fingerprints of two fingers, if possible one of each hand.
If you do not take this precaution, some important action will be impossible to execute by the user or the 
administrator in case where his recorded finger is injured so that its fingerprint cannot be recognized.

Step Action Online/
Offline?
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Chapter 6
Managing Users

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Managing Users 44
Exporting Users 48
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Managing Users

User Enrollment
Use this procedure to add a user to the user database (User list):

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as a Users-administrator. Offline
2

Click  above the Users list.
Offline

3 Enter the ID, and Comments (if necessary).

NOTE: The ID can be letters, numbers, or a mixture.

Offline

4 Record 1 or 2 fingerprints (see page 41) for the new user.
Result: The user is added to the Users list.

Online

GDPR RECOMMENDATION

RISK IF IDENTIFIER IS TOO EXPLICIT
The identifier of an administrator or a user must not be explicit.
It is strongly recommended to use pseudonym or codification for identifier.
Failure to follow these instructions can make it more difficult to comply with GDPR requirements.
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User Deletion
Use this procedure to remove users from the user database (Users list):

NOTE: To remove a user from an XB5S device Allocations column, refer to Remove a user 
(see page 55).

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as a Users-administrator. Offline
2 Select the user to delete.

NOTE: Use the CTRL key to select several users as targets for the delete operation.

Offline

3
Click  above the Users list.
Result: The Delete users dialog opens.

Offline

4 Click OK.
Result: The Administrator authentication dialog opens.

Online

5 Apply one of your enrolled fingers on the sensor of the XB5S device or the MorphoSmart 
device.
Hold the finger on the sensor about 2 seconds (sensor blink + 1 s) before removing it from 
the sensor.
Result: The Delete Users dialog opens.

Online

6 Click OK.
Result: The user is removed from the Users list.

Online

GDPR RECOMMENDATION

RISK TO BE NOT COMPLIANT WITH “RIGHT TO BE FORGOTTEN” ARTICLE 17 OF 
GDPR REGULATION
After deleting a user from the software database, you must store, in a appropriate delay, the new user 
databases in each related XB5S device.
The delay depends on your country regulation.
Failure to follow these instructions can make it more difficult to comply with GDPR requirements.
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User Contextual Menu
If you right-click on a user, a menu with the following items opens:

Item Used to ... Online/
Offline?

Modify User Update the user Comments. Also, if not already done, a second finger can 
be recorded.

NOTE: Double-clicking a user also allows modification of a user.

Offline

Replace User Replace the user with a new user that has the same allocations, see 
Managing Users (see page 44).

Offline

Delete User
Remove the user from the user list (the same as clicking  above the 
Users list).

Offline

Export User Refer to Exporting Users (see page 48). Online
Copy Copy the allocations of a user.

NOTE: See Copying/Pasting New Users (see page 47).
Offline

Paste Paste copied user allocations to another user.

NOTE: Use the CTRL key to select several users as targets for the paste 
operation.

Offline

Sort Users by Sort the user list by the ID, Date of record or Comments column. Offline
Filter Users Filter the user list to show only users that have the same ID, or 

Comments. They can also be filtered to show a range of Date of record.

When this list is filtered, a small icon appears above Users list:  
You can click this icon to directly open the Filter Users dialog.

Offline

Show/hide Users 
Properties

Show or hide any of the Finger 1, Finger 2, Date of record and Comments 
columns.

Offline

Show/hide Users Show or hide users in the list.

When users are hidden, a small icon appears above Users list:  
You can click this icon to directly open the Show/hide Users dialog.

Offline
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Copying/Pasting New Users
If you have many users to add to XB5S device, you can use certain programs to list the users you 
want to add.
To use Microsoft Excel:

To use Microsoft Word:

Step Action Online/
Offline?

1 In Excel, list the user ID in one column. Offline
2 Copy the column. Offline
3 Log to the Harmony XB5SSoft as a Users-administrator. Offline
4 In Harmony XB5SSoft, open the right-click contextual menu in the Users list and choose 

Paste or press CTRL+V.
Result: The users are added to the Users list.

Offline

5 Add fingerprints (see page 41) for each user.
Enter any necessary Comments.

Online

Step Action Online/
Offline?

1 List the user ID on a line. Offline
2 Repeat steps 1 each user on a new line. Offline
3 Copy all user lines. Offline
4 Log to the Harmony XB5SSoft as a Users-administrator. Offline
5 In Harmony XB5SSoft, open the right-click contextual menu in the Users list and choose 

Paste or press CTRL+V.
Result: The users are added to the Users list.

Offline

6 Add fingerprints (see page 41) for each user.
Enter any necessary Comments.

Online
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Exporting Users

Exporting Users
If GDPR-related features are enabled, a configuration-administrator can export the data related to 
a user in order to provide them to him on demand.
Use this procedure to export user data:

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as a configuration-administrator. Offline
2 Select one user in the Users list. Online
3 In the menu, select Users → Export User.

Result: The Dialog dialog opens.
Online

4 Type the password to use to create the ZIP file. Online
5 Type again the password in the Confirm password field. Online
6 Click OK.

Result: The Administrator authentication dialog opens.
Online

7 Apply the current configuration-administrator finger on the sensor of the XB5S device or 
MorphoSmart device.
Hold the finger on the sensor about 2 seconds (sensor blink + 1 s) before removing it from 
the sensor.
Result: A window opens to allow you to select the file location, and to modify the file name 
if needed.

Online

8 Click OK.
Result: The Zip file is created in the indicated folder.

NOTE: To unzip it, type the password provided in steps 4 and 5.
The embedded file type is .JSON. It can be opened and read in any text editor.

Online

GDPR INFORMATION

This feature is designed to help complying with GDPR requirements regarding personal data portability.
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Chapter 7
Managing Allocations

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Managing Allocations Columns 50
Managing User Allocations 55
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Managing Allocations Columns

Introduction
An allocation column is the link between users and the XB5S device. Each column corresponds to 
a different XB5S device. The column of the currently attached XB5S device has an icon in the 
header of the column.
The mains actions on the allocations columns are:
 Adding Columns (see page 51)
 Adding a column by plugging in an XB5S Device (see page 51)
 Deleting a Column Not Attached (see page 51)
When the column is already attached to a XB5S Device:
 Deleting an attached allocation column with the XB5S device (see page 52)
 Deleting an attached allocation column without the XB5S device (see page 53)
If a users-administrator right-clicks on a column, the allocation contextual menu (see page 54) 
opens.

Column Header
In the header of the column attached to a XB5S device there are 2 types icons:

In the header of the column, if the GDPR-Related features are enabled, GDPR-related feature 
capability of the XB5S device is also indicated:

Icon Description
The attached XB5S device is plugged to the PC.

The attached XB5S device is not plugged to the PC.

Icon Description
The GDPR-related feature capability of the XB5S device is enabled.

The GDPR-related feature capability of the XB5S device is not yet enabled.
It will be automatically enabled at the next communication with the PC.

The XB5S device has no GDPR-related feature capability.
50 EIO0000001538 04/2019



Allocations
Adding Additional Columns
Use this procedure to add a column to the Allocations list:

Adding a Column by Plugging in an XB5S Device
When you plug an undefined XB5S device into a USB port, you can select the option Add a column 
in the database and attach this XB5S to it to create the column and automatically attach the XB5S 
device to it.
For more details, refer to Adding an XB5S device (see page 32).

Deleting a Column Not Attached
Use this procedure to remove a column not attached to any XB5S device from the Allocations list:

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as a Users-administrator. Offline
2

Click  above the Allocations list.
Result: The Add column dialog opens.

Offline

3 Enter the Designation and any necessary Comments. Offline
4 Click OK.

Result: An information dialog opens.
Offline

5 Click Close.
Result: A new column is added to the Allocations list.

Offline

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as a Users-administrator. Offline
2 Select a column. Offline
3

Click  above the Allocations list.
Result: The Delete column dialog opens.

Offline

4 Click OK.
Result: The Columns successfully deleted! dialog opens.
The selected column is removed from the Allocations list.

Offline

5 Click Close. Offline
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Deleting an Attached Allocation Column with the XB5S device
Use this procedure to remove a column from the Allocations list and to remove the XB5S device 
from your equipment (The device can be reprogrammed with Harmony XB5SSoft.):

Results:
 Allocation column removed from Harmony XB5SSoft.
 User Allocations (x): cleared.
 XB5S device is reset (see page 58): empty user database.
 XB5S device detached (see page 34): XB5S device available for use in another context.

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as a Users-administrator. Offline
2 Plug the targeted XB5S device to the PC. Online
3 Select the column of the targeted XB5S device. Online
4

Click  above the Allocations list.
Result: The message Column XXX will be deleted. The connected device will be 
reset before deletion.

Online

5 Click OK.
Result: The Administrator authentication dialog opens.

Online

6 Apply one of your enrolled fingers on the sensor of the XB5S device or the 
MorphoSmart device.
Hold the finger on the sensor about 2 seconds (sensor blink + 1 s) before removing 
it from the sensor.
Result: The column is removed from the Allocations list and the XB5S device is 
detached (see page 34), reset (see page 58), and deleted (see page 54) from the 
database. The plugged XB5S device is no longer recognized by this database. 
Because it is now considered to be a new XB5S device, the Connection of a new 
device dialog opens.

Online

7 Click Cancel. Online
8 Unplug the XB5S device from the PC. Online
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Deleting an Attached Allocation Column without the XB5S device
It is recommended to use the following procedure to remove an XB5S device from service (for 
instance a broken one). As a result of this procedure the XB5S device can no longer be 
programmed with Harmony XB5SSoft.
Use this procedure to remove an XB5S device (A) from service:

Results:
 Allocation column removed from Harmony XB5SSoft.
 User Allocations (x): cleared.
 XB5S device unchanged.
 XB5S device still attached: XB5S device no more usable in any other context.
NOTE: To replace a broken XB5S device by another one, copy/paste the column before deleting 
it and then attaching a new device to the copied column.
NOTE: The removed XB5S device (A) must be disposed according to the rules of the company / 
organization using it.

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as users-administrator. Offline
2 Plug another XB5S device (B) to the PC. Online
3 Select the column of the device (A) to be removed from service. Online
4

Click  above the Allocations list.
Result: The Administrator authentication dialog opens.

Online

5 Apply one of your enrolled fingers on the sensor of the XB5S device or the 
MorphoSmart device.
Hold the finger on the sensor about 2 seconds (sensor blink + 1 s) before removing it 
from the sensor.
Result: The message is displayed: Deleting this column makes device unusable with 
Harmony XB5SSoft.

Online

6 Click OK.
Result: It is impossible to program this XB5S device (A) with Harmony XB5SSoft.

Online

7 Unplug the XB5S device (B) from the PC. Online
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Allocations Contextual Menu
If a users-administrator right-clicks on a column, a menu with the following items opens:

Item Used to ... Online/
Offline?

Modify Description Modify the Designation and Comments. Offline
Detach XB5S from 
column

Detach the XB5S device from its column:
 It requires the current logged-in user-administrator fingerprint 

authentication.
 The XB5S device is reset (see page 58).
 The users are not removed from the column.

NOTE: This feature is recommended when this device needs to be 
used in another context or another database or to replace an XB5S 
device by another XB5S device. This new XB5S device can be attached 
to same column as the old XB5S device using Attach XB5S to column.

NOTE: Refer to Detach XB5S from column (see page 34).

Online

Attach XB5S to column Attach the unattached XB5S device to a column. Online
Delete Column Delete a column and its user information.

NOTE: Refer to Deleting a Column (see page 51).
Offline

Copy Copy a column with its user information. Offline
Paste Paste the copied column to the target column.

NOTE: Use the CTRL key to select several target columns.

Offline

Sort Columns by Sort the columns by the Designation, ID, Date of last update or 
Comments.

Offline

Filter Columns Filter the columns to show only columns that have the same Designation 
or Comments. They can also be filtered to show a range of Date of 
update.
When a column is filtered, a small icon appears above Allocations list: 

.
You can click this icon to directly open the Filter Columns dialog.

Offline

Show/hide Columns Show or hide the columns according to their Designation.
When columns are hidden, a small icon appears above Allocations list: 

.
You can click this icon to directly open the Show/hide Columns dialog.

Offline
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Managing User Allocations

Adding a User Allocation
To allocate a user to an Allocations column, double-click the line in the column that corresponds 
to the user.
An X* appears in the column line. The “*” means that the database has not been stored 
(see page 57) into the attached XB5S device since the user was allocated to the XB5S device 
column.
NOTE: Up to 200 users can be assigned to a column, that is, 200 users (with 1 or 2 fingerprints) 
per XB5S device. 

Removing a User Allocation
To remove a user from an XB5S device Allocations column, double-click the line in the column that 
corresponds to the user.
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Chapter 8
Storing and Resetting an XB5S Device

Storing and Resetting

Store Procedure
NOTE: Never unplug the XB5S device during the store operation. Unplugging it during a store 
operation may make the XB5S device no longer programmable by Harmony XB5SSoft. 
Use this procedure to download the user database from the PC to the connected XB5S device:

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as a users-administrator. Offline
2 Do one of the following actions:

1. Click Store icon.

2. In the menu, select XB5S Device → Store to XB5S
Result: The Store to XB5S dialog opens.

Online

3 If you agree with the message in the dialog, click OK.
Result: The Administrator authentication dialog opens.

Online

4 Apply one of your enrolled fingers on the sensor of the XB5S device for 2 s.
Result: The Store to XB5S dialog opens again.

Online

5 When the Storage successful message appears, click Close.
Result: The allocated users are stored in the target XB5S device.

Online
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Reset Procedure
NOTE: Never unplug the XB5S device during the reset operation. Unplugging it during a reset 
operation may make the XB5S device no longer programmable by Harmony XB5SSoft.
Resetting the current connected XB5S device erases all data stored in its memory.
Use this procedure to delete all data in the connected XB5S device:

Results:
 Allocation column unchanged.
 User Allocations (x): unchanged.
 XB5S device is reset (see page 58): empty user database.
 XB5S device still attached to the allocation column.

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as a users-administrator. Offline
2 Do one of the following actions:

1. Click Reset icon.

2. In the menu, select XB5S Device → Reset XB5S
Result: The Reset XB5S dialog opens.

Online

3 Apply one of your enrolled fingers on the sensor of the XB5S device for 2 s.
Result: The Reset XB5S dialog opens again.

Online

4 Click Close.
Result: All data in the XB5S device is erased by storing an empty user database in it.
The Allocations column content for the XB5S device is not affected.

Online
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Chapter 9
Managing Device

Managing Device

Introduction
Several functions are used to manage an XB5S device depending on your needs:
 Connect a Device
 Reset a Device
 Attach a Device
 Detach a Device
 Replacing a broken XB5S device by a new one
When the column is already attached to a XB5S Device:
 Deleting an attached allocation column with the XB5S device (see page 52)
 Deleting an attached allocation column without the XB5S device (see page 53)

Connect a XB5S device Function
Plugging in a new XB5S device on the PC launches the Connect XB5S device (see page 32) 
procedure that makes you able to:
 Create a new allocation column and attach the XB5S device to it
 Attach the XB5S device to an existing allocation column (the column must not be already 

attached to another XB5S device).

Reset Function
The reset XB5S device function allows erasing the memory in the device while keeping it attached 
to the allocation column.
For more details, refer to Reset procedure (see page 58).

Attach Function
The attach function allows linking a previously detached XB5S device to an allocation column of 
the Harmony XB5SSoft database. The XB5S device is then usable exclusively with this database.
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Detach Function
The detach XB5S device function allows detaching and resetting an XB5S device while keeping its 
Allocations configuration in the database.
The detach XB5S device function is the best way to replace an XB5S device by a new one. This 
is because it keeps the Allocations configuration of the original XB5S device. By attaching the new 
XB5S device to the column of the original device, the new device (after a store (see page 57) 
operation) has exactly the same configuration as the old device.
For more details, refer to Detach XB5S Device for Replacement (see page 34).

Replacing a Broken XB5S Device by a New One
Use this procedure to replace an out-of-order XB5S device (A) by a new XB5S device (B):

Results:
 Allocation column: unchanged (if you renamed it correctly)
 User Allocations (x): unchanged.
 XB5S device (A) unchanged but no more usable in any other context (not programmable by 

neither Harmony XB5SSoft).
 XB5S device (B) replace the out-of-order XB5S device (A).

Step Action Online/
Offline?

1 Log to the Harmony XB5SSoft as users-administrator. Offline
2 Create a new allocation column (see page 51) for the XB5S device (B).

Copy/Paste the user allocation content of the XB5S device (A) column into the XB5S 
device (B) column.
Rename the allocation column attached to the XB5S device (A) and the XB5S device (B).

Online

3 Plug the new XB5S device (B) and attach it to the new allocation column. Refer to connect 
an XB5S device (see page 32).

Online

4 Select the allocation column of the XB5S device (A) to be replaced. Online
5

Click  above the Allocations list.
Result: The Administrator authentication dialog opens.

Online

6 Apply one of your enrolled fingers on the sensor of the XB5S device for 2 s.
Result: The message is displayed: Deleting this column makes device unusable with 
Harmony XB5SSoft.

Online

7 Click OK.
Result: It is impossible to program XB5S device (A) with neither Harmony XB5SSoft.

Online

8 Store the user database into the XB5S device (B) (see page 57). Online
9 Unplug the XB5S device (B) from the PC. Online
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Troubleshooting

Introduction
Using this table to find the solution to issues you have with Harmony XB5SSoft:

Issue Cause To Solve the Issue
1 While capturing a fingerprint 

using an XB5S device or 
MorphoSmart device, 
Harmony XB5SSoft takes a long 
time to display the three steps of 
capture.

The glass of the biometric switch 
sensor is dirty. 

Regularly clean the glass of the 
biometric device sensor.

2 When you copy several users and 
paste them in 
Harmony XB5SSoft; you get a 
detected error message.

It is not possible to have a user ID 
more than one time in the grid.

Pasting users as new users is only 
possible if the users have been copied 
from outside Harmony XB5SSoft (for 
example, Word or Excel).
Verify that all IDs are different.

3 You have lost your 
Harmony XB5SSoft password.

Ask a configuration-administrator 
(different from the one who has forgotten 
his password) to allow you to change 
your password. Refer to change 
password procedure (see page 39).
ATTENTION: If there is no other 
configuration-administrator recorded, 
you are not able to log to this 
Harmony XB5SSoft anymore.

4 When connecting a device, you 
get the following message: “The 
connected device is used and 
programmed by another 
database. You will not be able to 
program it or reset it with this 
database”

The XB5S device has been 
programmed on another PC. A 
biometric switch content cannot 
be modified by any PC. It can be 
reset or re-reprogrammed only by 
the PC using the database which 
has previously programmed it.

Detach (see page 34) the XB5S device 
biometric switch from its original 
database to be able to program it by a 
new database.
If you do not have access to the original 
database, contact Schneider Electric;

5 When detaching a device, you get 
the following message: “The 
XB5S device (‘serial number’) 
must be connected to be 
detached from column (‘column 
designation’)”.

The detach (see page 34) 
operation resets the associated 
XB5S device to make it usable by 
any other PC with 
Harmony XB5SSoft.

Plug the indicated XB5S device that is 
attached to the indicated column to carry 
out the detach (see page 34) operation.
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6 A XB5S device, declared as a 
reader, cannot be attached to a 
column.

Only a biometric switch declared 
as an XB5S device can be 
attached to a column.

Remove this device from the list of 
readers:
 Tools → Read devices 
 Select the relevant device
 Click Delete selected device

The Connection of a new device 
dialog opens. 

 Click use it as a Harmony XB5S 
device

To attach the XB5S device to a column, 
you must apply the following function:
Command menu Allocations → Attach 
XB5S to Column.

7 In the lower right status bar, it 
says “Several devices are 
connected”.

Harmony XB5SSoft can manage 
only one device at a time.

Disconnect all but one device so that 
only one device remains connected to 
the PC.

8 You get the following message 
“Only one configuration-
administrator is recorded” each 
time you launch 
Harmony XB5SSoft.

You have only one configuration-
administrator enrolled.

Record a second configuration-
administrator as soon as possible.

NOTE: If only one configuration-
administrator is enrolled and that 
administrator is not available, nobody 
will never be able to do any of the tasks 
reserved to a configuration-
administrator in this database.
ATTENTION: If there is only one 
administrator (merging the 
configuration-administrator profile and 
the users-administrator profile), nobody 
will never be able to use this database 
anymore.
ATTENTION: In these cases, even 
Schneider Electric has no means to 
allow someone to use the database (in 
order to provide the best-possible 
personal data protection).
As a result you will need to delete your 
database and to recreate a new 
database, and thus to record again all 
the users.
For all the XB5S devices used in this 
database, you will have to use the 
procedure detailed in the topic 4 of this 
table.

Issue Cause To Solve the Issue
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9 The database administrator(s) 
are unavailable.

Administrator(s) left the company 
or are otherwise no longer 
available.

It there is at least one remaining 
configuration-administrator available, he 
just have to create a new one, and to 
remove the unavailable one from the 
database.
If there is no remaining configuration-
administrator, see topic 8 of this table.

10 You are an administrator of the 
database and you want to use an 
XB5S in the operational mode.

Administrators of 
Harmony XB5SSoft are not 
stored in the XB5S device. Only 
users are recorded in the XB5S 
device.

You must be enrolled as a user.

Issue Cause To Solve the Issue
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A
Allocation column

An allocation column is the link between users and the XB5S device. Each column corresponds to 
a different XB5S device.

Attach
Attach function allows you to link a XB5S device to an allocation column of the Harmony XB5SSoft 
database.
Result: XB5S device is then usable exclusively with this database.

C
Connect function

Connect function allows you to attach a XB5S device to an allocation column of the 
Harmony XB5SSoft database.
Result: XB5S device is then usable exclusively with this database.

D
Detach

Detach function allows you to unlink an attached XB5S device from the allocation column of the 
Harmony XB5SSoft database.
Result: XB5S device is available for use in another Harmony XB5SSoft database.

G
GDPR

(General Data Protection Regulation): GDPR is a regulation in EU law on data protection and 
privacy for all European individuals. GDPR is dedicated for only EU area and it provides data 
protection and privacy for all European citizens in EU.
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R
Reset

Reset function allows you to erase all data in the XB5S device by storing an empty user database.
Result: All data in the XB5S device is erased by storing an empty user database in it.
Result: XB5S device is still attached to allocation column of the Harmony XB5SSoft database.
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